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In January 2013 all forty courses that comprise Phase II of the Open Course Library 
(OCL) were reviewed for accessibility as a first step in ensuring these materials are 
accessible to students and faculty members with disabilities. The outcome of this 
review is a set of documents, as follows:  

 Summary and Recommendations (the current document).  
This document provides an overview of the project, a complete list of 
problems and how to fix them, and a summary of findings and 
recommendations.  

 Course Accessibility Inventory (CAI) 
A CAI was prepared individually for each course. These documents contain a 
complete listing of all files included in a course, organized by folder. For each 
file, a bulleted list of the most critical accessibility problems is provided. In 
some cases additional details are included, but in order to avoid redundancy 
most problems are explained in the current document, in the Accessibility 
Problems and Solutions section.  

Courses were in various stages of completion at the time of review. Therefore the 
CAI for each course may not reflect the final course content, but hopefully reflects 
the types of issues course authors are most likely to encounter as they continue to 
develop that course.  

How to Use This Information  

If you are the author of one or more course curricula, the current document is 
designed to supplement the CAI for your particular course(s). A recommended 
course of action is:  

1. Review the current document in order to gain an understanding of this 
accessibility review.  

2. Review the CAI for your course(s). Each accessibility problem that is 
identified in the CAI is explained in detail below.  The explanation includes a 
recommendation for how to fix the problem.   

If you are a faculty member who is considering using course materials, the current 
document and CAI for your course(s) is provided in order to disclose the nature, 
quantity, and severity of accessibility problems in the course you're considering. 
You are responsible for ensuring the accessibility of your course. The combined 
components of this report are intended to provide you with sufficient details to 
perform that task.  
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Why Accessibility?  

Higher education institutions have ethical and legal obligations to ensure their 
programs, services, activities, and resources are accessible to all qualified 
participants. This includes students and faculty members who have disabilities. 
Information technology has the potential to serve as a great equalizer, enabling 
individuals who are blind or low vision, deaf or hard of hearing, physically disabled, 
or cognitively disabled, to fully participate in higher education and society. Assistive 
technology has become highly sophisticated and any individual who can breathe 
and control at least one muscle can operate a computer.  

Unfortunately, information technology often fails to live up to this potential.  There 
are specific authoring techniques required for creating electronic documents, web 
pages and applications that are fully accessible to all users. Unless these techniques 
are followed when authoring electronic resources, accessibility problems arise that 
could prevent students or faculty members with disabilities from using these 
resources easily or at all.     

Federal law prohibits discrimination against individuals with disabilities by 
recipients of federal funding (Section 504 of the Rehabilitation Act of 1973) and 
public entities, places of public accommodation, and places of employment 
(Americans with Disabilities Act of 1990). Most if not all higher education 
institutions in the United States must comply with one or both of these laws. These 
laws require that programs, services, activities, and resources be accessible to all 
qualified participants.  

Standards and guidelines for creating accessible electronic content have existed 
since the late 1990's, and are actively being updated today to reflect changes in 
technology.  Current standards include the World Wide Web Consortium's (W3C) 
Web Content Accessibility Guidelines (WCAG) 2.0 and the Electronic and 
Information Technology Accessibility Standards, which were developed by the 
federal Access Board to support Section 508 of the Rehabilitation Act, a law passed 
in 1998 that all electronic and information technology developed, procured, or used 
by federal agencies to be accessible. The WCAG was updated to version 2.0 in 
December 2008 and the Access Board is currently working on an update to the 
Section 508 standards that is likely to be closely aligned with WCAG 2.0. Also, the 
U.S. Department of Justice has proposed new rules that clarify the precise 
requirements for web accessibility under the ADA, and early communications from 
the DOJ suggest that the new ADA rules will also be closely aligned with or informed 
by WCAG 2.0.    

Accessibility of OCL course content depends to a large extent on how the course is 
delivered to students. For example, even if the curriculum is fully accessible, if it's 
delivered in an inaccessible learning management system (LMS), students with 
disabilities might find it to be entirely inaccessible.  The problems and solutions 
described below pertain solely to the curriculum content.  Faculty members, 



information technology (IT) administrators and other decision makers at 
institutions where the curriculum is used must take additional care to ensure their 
LMS and other IT tools are accessible. This is beyond the scope of the current 
review. However, our hope is that this review will help to ensure the materials 
provided by the OCL are fully accessible, so faculty members are at least starting 
with a fully accessible course.   

Accessibility Problems and Solutions 

The following are the most critical accessibility problems found in OCL courses, and 
recommendations for how to fix them.  

Alt Text on Images 

Images need to have alternate text in order to be accessible to non-visual users. 
Users who are blind access electronic documents using either a text-to-speech 
software application commonly referred to as a "screen reader" or a Braille output 
device connected to their computer. When they encounter an image, their assistive 
technology reads the content of the alternate text ("alt text") that the author has 
provided for that image.  

Alt text should be succinct, and should be written with the goal of communicating to 
non-visual users the same key idea that sighted users have access to by looking at 
the image. One approach to authoring alt text is to imagine describing that image to 
someone over the phone.  Include all of the important information, but avoid details 
that are not integral to the core message conveyed by the image. 

Alt text is often associated with web page accessibility. However, it is also possible 
(and equally important) to add alternate text to images in other applications too, 
including Microsoft Word docs, PowerPoint presentations, and Adobe PDF files.  

Responsible party: Images should be described by the author of the curriculum, or 
by a designee who the author feels has sufficient understanding of the curriculum's 
content.  

NOTE: This problem cannot be fixed in Google Docs.  

How to fix this problem in Microsoft Word or PowerPoint:   

The procedure is the same in Word and PowerPoint. To add alt text to images, 
simply right click on an image, and select "Format Picture" (in Office 2007, select 
"Size and Position").  



  

A dialog will appear that includes an option to add Alt Text. In Office 2010 or higher, 
there are two fields associated with alt text, a short Title field and a longer 
Description field. Enter your alt text into the Description field.  

How to fix this problem in Adobe PDF:   

Adobe PDF supports alt text on images, but the process for adding them is more 
complicated than in Microsoft Office. The best solution for making accessible PDF's 
is to add accessibility within the original source document (e.g., in Microsoft Word), 
then export to an accessible tagged PDF. Most accessibility features, including 
headings and alt text, are preserve if you export properly (consult the PDF section of 
this document for more details).  

NOTE regarding complex images that require long descriptions:  Alt text as 
described above is intended to be short and sweet. Some images are too complex to 
be described in this fashion, and require a long description, which communicates the 
most important details that readers are expected to get from the image. Examples of 
images that require a long description are charts, graphs, flowcharts, and comics. 
There is no formal mechanism for providing a long description in Google Docs or 
Microsoft Word. Therefore one method is to provide a description of the image in a 
separate document, or as an appendix to the current document, and clearly 
referencing it adjacent to the image (e.g., "For a description of this image see 
Appendix A"). The National Center for Accessible Media has developed Guidelines for 
Describing STEM Images. The following publication includes these guidelines, plus a 
variety of excellent examples: 
http://ncam.wgbh.org/experience_learn/educational_media/stemdx 

Color 

There are two important considerations related to color:  

http://ncam.wgbh.org/experience_learn/educational_media/stemdx


1. Be sure there is high contrast between the color of foreground text and 
background color. Most of the curriculum uses black on white, but there are a 
few exceptions. If dark text appears on a dark background or light text 
appears on a light background, some individuals will find reading the text to 
be challenging if not impossible. 

2. Always be mindful that many individuals are color blind. Content that uses 
color as the sole means of distinguishing between information (e.g., red line 
means X, blue line means Y) is inaccessible to people who are unable to 
distinguish between colors.  

How to fix this problem in Google Docs:   

If a course uses colors that could present accessibility problems as explained above, 
change those colors. For text, the OCL has standardized on black text on a white 
background. Use that for maximum accessibility and for consistency within and 
between courses.  

Note: Colors are preserved when documents are imported or exported between 
Google Docs and Word.  

 

Math 

Of all academic disciplines, Mathematics is perhaps the most challenging in which to 
practice universal design, i.e., developing one curriculum that is accessible and 
effective for the broadest possible range of students. The group that faces the 
greatest challenge to math accessibility is students who are blind. Strategies for 
teaching math to blind students have been evolving for centuries, and are still highly 
individualized.  

In recent years, MathML has gained growing support as the standard markup 
language for communicating mathematical formulas in electronic documents. A 
growing number of web browsers and assistive technologies support MathML, and 
there are a number of products that support authoring and editing of MathML 
content, including MathType, a plug-in for Microsoft Word developed by Design 
Science (http://dessci.com), who also developed Word's built-in Equation Editor.   
The best strategy for producing documents that contain accessible formulas would 
be to author them using a tool that supports MathML. In Microsoft Word, formulas 
could be created using MathType and documents could be exported to 
XHTML+MathML so screen reader users could access these formulas.   

This most important consideration is that formulas and equations be created with 
an underlying structure (i.e., as a math object) rather than an image. If they have 
structure, they can be converted to another format that best meets the needs of 
individual students. If they are just images of formulas, the only way to make them 
accessible to re-create  them from scratch.  Note that the  underlying structure of 
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equation objects may or may not survive when converted to/from Google Docs.  
Course authors should test this before determining the best approach for delivering 
their content.  

More information about MathML is available in the UW DO-IT Knowledge Base: 
https://www.washington.edu/doit/articles?379 

Another consideration is highly visual content such as graphs. A variety of strategies 
have emerged for providing access to visual representations, including tactile 
graphics (raised dots or lines produced via an embosser or other technology) and 
audible technologies that use tone to represent equations and graphs. Often 
students learn best from a hybrid of these solutions, integrating multiple techniques 
and modalities. For additional information about tactile graphics see the Tactile 
Graphics section below.  

Making a math course fully accessible also requires rethinking the teaching methods 
with consideration of all learners.  How does your course address the three 
principles of "universal design for learning (UDL)" (multiple means of 
representation; action and expression; and engagement)?  Could a particular 
concept be taught another way, to complement the current method? Are there 
different ways that students could demonstrate their understanding? Additional 
information about UDL is available at http://www.cast.org/udl/ 

Given the complexities of math accessibility, this report makes no specific 
recommendations beyond those provided in this section, but OCL officials and 
faculty are encouraged to consider how they might go about creating one ore more 
open math courses that embrace universal design and establish global models of 
accessible math curriculum. This would be a large undertaking, but one that would 
certainly be worthwhile and perhaps could attract grant funding. The Washington 
State School for the Blind might be an excellent partner in such a project:  
http://accessiblemath.dessci.com/2012/09/school-for-the-blind-leads-the-way-in-
accessible-math.html 

Headings 

This is arguably the greatest accessibility problem, and the easiest to fix. Most 
electronic documents have an organizational structure that is communicated by its 
headings and subheadings. Typically there is a main heading  (e.g., a title) at the top 
of the document, several secondary headings, and possibly a third or fourth level of 
headings in longer, deeper documents.  

Headings must be explicitly marked up as headings at the appropriate level (e.g., 
Heading 1, Heading 2, etc.) If text is simply made bold and larger to make it look like 
a heading, it may appear as a heading to sighted users, but it isn't really a heading, 
and non-sighted users don't have access to these same visual cues. To non-sighted 
users, a document without headings has no structure, no organization. It can be very 
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challenging to figure out when one section ends and the next one begins, and how all 
the parts of the document relate to one another.  

Also, assistive technology uses headings to facilitate navigation. For example, many 
screen readers include functionality that enables users to navigate from heading to 
heading within a document by simply pressing a single key. With this functionality, 
users can scan a document before reading it, in order to understand its overall 
content and structure. Then they can jump quickly to a particular section that meets 
their needs. If the document contains no actual headings, there is no way for non-
visual users to do this. The document is just one long string of text from start to 
finish, with no organization or structure.    

Responsible party: Headings can be added to documents by anyone. Ideally the 
author will use headings when creating the document. However, if that doesn’t 
happen, headings can be added later by the author or by anyone with knowledge of 
the technique.  

How to fix this problem within Google Docs:   

Consider the overall structure of your document, and determine which text should 
be identified as a heading, at what level ("Heading 1", "Heading 2", etc.). The 
headings in your document should form an outline, with Heading 1 at the top.   

Then, select the first block of text you want to identify as a heading. Choose the 
appropriate heading level from the "Styles" dropdown in the Google toolbar.  

 

How to fix this problem within Microsoft Word:   



The procedure is essentially the same as for Google Docs. To identify headings of 
various levels, select the appropriate heading level from the Ribbon (under the 
Home tab)  

 

Note: Headings are preserved when documents are imported or exported between 
Google Docs and Word.  

Justification 

Text documents written in left-to-right languages such as English, Spanish, and 
French should always use left justification. Full justification is difficult to read, 
especially for individuals with specific learning disabilities such as dyslexia, who 
may have difficulty tuning out the disproportionate spaces.  

Language 

Most screen readers are multi-lingual, and any non-visual student enrolled in a 
foreign language course is likely to be using a screen reader that supports both 
English and the foreign language. If a document contains mixed languages, as is 
likely in a foreign language course, screen readers are capable of switching on the fly 
from one language to the other, and reading the content in fluent English, French, 
Spanish, or other supported languages. Unfortunately, screen readers are not yet 
intelligent enough to recognize languages. They must be told what the language is, 
then they can read it correctly.   

Therefore, if a document contains content in multiple languages, the document must 
be assigned a primary language (identified within the file properties). Then, any text 
that deviates from that primary language must also have its language explicitly 
identified in the code behind the scenes.  

Currently, screen readers that support on-the-fly switching between languages only 
do so within HTML web pages, Microsoft Word documents, and Adobe PDF files. 
Other document formats (e.g., Microsoft PowerPoint) must be converted to one of 



these other formats before defining the language of its content (see below for 
additional details).  

Responsible party: Language changes within a document can be identified by 
anyone who knows the technique and is able to distinguish between the languages 
used on the page.  

NOTE: This problem cannot be fixed in Google Docs.  

How to fix this problem in Microsoft Word:   

In Microsoft Word, the accessibility solution is to define the proofing language. This 
is the language used for spell-check, but it also works for assistive technologies. The 
Language options are located in different places depending on your version of Word. 
In Word 2010 for Windows, it is under Review > Language > "Set Proofing 
Language". In Word 2011 for Mac, it is under Tools > Language.  Once you've located 
the Language option for your version of Word, simply follow these steps:  

1. With no text selected, define the language for the entire document, then save 
the document.  

2. Select each word, phrase, or block of text that deviates from the default 
language of the document. The larger the block, the fewer times you will have 
to follow this procedure. However, text must be adjacent and uninterrupted. 
Once you've made your selection, define the language for that selection.  



 

 

Note: As of Word 2010 and 2011, the language settings do NOT get exported from 
Word to PDF. Therefore, you should only define the languages within Word if Word 
is your final format. If your final format is PDF, follow the steps in the following 
section.  

How to fix this problem in Adobe PDF: 

In order to modify language within PDF documents, the PDF must first be tagged. 
For more information on tagged PDF, see the PDF section below.  Once the 
document is tagged, language can be added to the entire document as well as to 
individual parts using Adobe Acrobat Pro. The procedure is essentially the same as 
the procedure for Word: Define the default language of the document, then select 
and define the language of each word, phrase, or block of text that deviates from the 
default. In Adobe Acrobat Pro X, the specific steps are as follows: 

1. Select File > Properties. Select the "Advanced" tab from the "Document 
Properties" dialog, then select the default language from the Language option 
(near the bottom of the dialog). Save the document.  

2. To modify the language of individual parts, you need to navigate the 
document's "tag tree". To access the "tag tree", select View > Show/Hide > 



"Navigation Panes" > Tags.  With the tag tree visible, select the foreign 
language text. Then click on the Options icon at the top of the Tags panel and 
select "Find Tag from Selection" from the dropdown menu. The tag for your 
selected text will be expanded and highlighted in the Tags panel. Now that 
you have located the tag, right click on that tag and select Properties. One of 
the properties that can be defined for this tag is Language. 
 

 Note: Working with PDF tags is an advanced skill, well beyond the scope of 
this report. However, defining language is a repetitive process that can be 
executed by almost anyone with a little training and guidance. Be sure to 
save the document regularly, as there is no Undo when working with PDF 
tags.   
 

How to fix this problem in Microsoft PowerPoint: 
 
The procedure for fixing this problem in PowerPoint is identical to Microsoft Word. 
However, no known screen reader supports multiple languages within a single 
PowerPoint file. Hopefully this will be corrected soon. Meanwhile, the best way to 
provide multi-lingual PowerPoint content in an accessible format is to export it to 
Word, then follow the above procedure to identify language within the Word file.  
 
There are numerous techniques for exporting to Word, including three described in 



this article in PPT Garden: http://pptgarden.blogspot.com/2011/12/3-methods-to-
convert-powerpoint-to-word.html  
 
Any of these techniques is fine, but the Word file that you create needs to have all 
the accessibility solutions applied to it that are discussed throughout this report, 
including using good heading structure, adding alternate text for images (if there are 
any), and identifying changes in language.  
 

Lists 

Whenever content is comprised of lists of items, it is important to use the built-in list 
features of the authoring tool or word processing application, including Google Docs 
and Microsoft Word.  Most word processing applications include buttons on their 
toolbar that can be used for creating bulleted lists or numbered lists.  

 

If lists are created using these built-in list features, screen readers and Braille 
devices are able to relay important information to the user about those lists. For 
example, when a user arrives at a list the assistive technology will announce the 
number of items in the list, and later in the list users can request their current 
position in the list (e.g., "list item 5 of 10"). Sighted users get this information at a 
glance, and it has a larger influence than one might think on enabling users to scan 
and read documents efficiently.   

In some cases (e.g., on quizzes or exams where spacing is inconsistent between 
numbered items) it might not be practical to format these as lists.  Accessibility will 
ultimately depend on how the questions are presented to the user.  

Responsible party: Lists can be identified by anyone who knows the technique.  

Note: Numbered and bulleted lists are preserved when documents are imported or 
exported between Google Docs and Word.  
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PDF 

It is possible for Adobe PDF documents to be highly accessible, but it is also possible 
for them to be entirely inaccessible. In order for PDFs to be accessible, they must be 
created using tools that support accessibility, and particular procedures must be 
followed.  

In general, there are three broad types of PDF:  

1. Scanned images. These have no text content (even if they appear visually as 
text), and are therefore completely inaccessible to people who rely on screen 
readers (including people with specific learning disabilities, as well as blind 
users). The first step in making these documents accessible is converting 
them to readable text.   

2. Documents with embedded text, but no tagged structure. These are the most 
common type of PDF, typically created by printing to PDF or saving as PDF 
from a document authoring tool or other software application. Without an 
underlying "tagged structure", these are not fully accessible documents, and 
often they have major accessibility problems such as incorrect reading order. 
Tagged structure can be added and massaged using Adobe Acrobat Pro, but 
this requires specialized skills in making PDF documents accessible.  

3. Tagged PDF. These documents have an underlying tagged structure that 
makes it possible to identify headings, lists, alternate text on images, table 
rows and other information that is key to accessibility as explained 
elsewhere in this report. In order to create tagged accessible PDFs, the 
author must use software that supports that (e.g., Microsoft Word for 
Windows), and must start with an accessible source document (with 
headings, alternate text, etc.) before exporting to PDF.  

The University of Washington has developed a set of workflows for how to create 
accessible PDFs using common software applications including Microsoft Word, as 
well as workflows for retrofitting inaccessible PDF's to make them accessible. 
Consult the UW PDF Accessibility page for additional information: 
http://uw.edu/accessibility/pdf.html 

Style 

Avoid excessive use of mixed fonts, bold, underlined, italicized, upper case and 
colored text – these features, if used in excess or used inconsistently, can cause 
confusion and can be very difficult for some individuals to read, especially those 
with specific learning disabilities such as dyslexia.  

Tables 



Tables should be used to communicate relationships between data, where those 
relationships can best be communicated using rows and columns. Tables should not 
be used solely for visual effect (e.g., to place a border around a single column of 
content). Doing so unnecessarily complicates the document with an extra layer of 
structure that screen reader users need to make sense of.  If a border is necessary, 
that can be added to any structural element (headings, paragraphs, etc.) using the 
Borders button, which is available in both Google Docs and Microsoft Word.  

If a table is necessary to show relationships between data, care should be taken to 
ensure that these relationships are clear. Often the best table is a simple 2-
dimensional table where the first row contains column headers that apply to every 
data cell in that column; and the first column contains row headers that apply to 
every cell in that row. If a table is more complex than this, consider whether the 
information could be presented differently so that it's easier to understand. Often 
content that's presented in one table could be divided into several smaller tables 
with a heading above each.  

All users benefit from good, usable table design, but the group that benefits the most 
is non-visual users reading a table using screen readers or Braille devices. These 
assistive technologies read tables linearly from top to bottom and left to right. When 
reading a linearized table, it's easy for users to get lost or to lose track of which 
column they're in. Keeping tables simple helps to minimize confusion.  
 
Also, the column headers should be explicitly identified as such. Doing so provides 
clarity to assistive technologies about the structure of the table, and they can relay 
that information on to users.  Even a very large table with many rows and columns 
can be easy to navigate and track as long as users are constantly aware of which 
column they're in (via the header for that column).  The most popular screen reader 
(JAWS) automatically assumes the first row in a data table contains the column 
headers. Because of this, if your table is a simple table, explicitly identifying the 
header row is a lower priority compared to other accessibility problems described 
in this report.  

NOTE: This problem cannot be fixed in Google Docs.  

How to fix this problem in Microsoft Word:   

1. Be sure your table has good, clean structure, with each row representing one 
data object and each column representing one attribute of that data object. In 
most tables the top row should be a row of column headers, clearly labeling 
the content within each column.  

2. Select the header row, then right click and select "Table Properties" from the 
pop-up menu. 
 



  
3. In the Table Properties dialog,  select the "Row" tab and check the box that 

says "Repeat as header row at the top of each page". Then click OK. 
 

 

NOTE regarding complex tables:  

If a table has an especially complex table (e.g., has nested rows or columns), and it is 
not feasible to present this information differently so that it uses simpler tables, this 
table requires additional markup in order to make it accessible, and this can only 
occur in HTML or Adobe PDF. It is not currently possible in either Google Docs or 
Microsoft Word to make a complex table accessible. The process for creating 
accessible complex tables in HTML and PDF is complex, requiring specialized skills 
in accessible coding.  There are two options for making these tables accessible:  



1. Export the entire document to HTML or PDF, and have an accessibility expert 
fix the accessibility.  

2. Export only the complex table(s) to HTML or PDF, and link to these 
alternative versions within the body of the main document (e.g., "<link>View 
an HTML version of this table</link>")  

Tactile Graphics 

The Open Course Library contains many graphs, charts, maps, and diagrams, 
particularly in math and science –related courses. In some cases these can be 
effectively described (see the above section on Alt Text on Images). However, in 
some cases the spatial positioning and orientation of the image's components or 
other visual characteristics may be an essential part of the communication, and it 
isn't possible to effectively describe the image. In these cases, a solution for many 
students is tactile graphics, images that are printed or embossed as raised dots or 
lines using special equipment designed for this purpose.  
 
Before an image can be produced in a tactile format, it typically must be optimized 
by removing unnecessary detail and making other changes that help users to 
appreciate the distinct characteristics of the image.  It's important for faculty to be 
involved at some level in this production process so they can confirm that all key 
information is present in the modified image. The OCL could be enhanced by 
providing a repository of such materials, clearly identified as to which course, unit, 
module, and lesson they're affiliated with; and converse clearly identified within the 
context of each course. By creating these materials up front and offering them along 
with OCL course materials, the faculty members who use these materials are 
relieved of the burden of having to do it themselves (in collaboration with the 
disability services offices on their campus).  
 
The process of preparing following resources provide additional information:  

 Braille Authority of North America's Guidelines and Standards for Tactile 
Graphics:  
http://www.brailleauthority.org/tg/web-manual/index.html 

 Tactile Graphics: A How-To Guide  
http://www.tactilegraphics.org/ 

Also, images that are used commonly in education are likely to be available from 
various central libraries, and could possibly be distributed for free in the OCL if the 
faculty who needs them feels they adequately meet the needs of their course. Tactile 
graphic libraries include:  

 Tactile Graphic Image Library @ American Clearing House for the Blind: 
http://www.aph.org/tgil/ 

 The Tactile Library 
http://www.tactilelibrary.com/ 

http://www.brailleauthority.org/tg/web-manual/index.html
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http://www.tactilelibrary.com/


Video 

Videos pose accessibility problems for many groups of users.  Individuals who are 
deaf or hard of hearing are unable to access the audio content unless the video is 
captioned. Individuals who are blind are unable to access the visual content unless 
it's described in the program audio or in a separate narration track. Individuals who 
are deaf-blind or those with and without disabilities who are attempting to access 
video over a slow Internet connection may be entirely unable to access video 
content, and therefore depend on a transcript.  

Fortunately there are many free tools available for transcribing and captioning 
video. One in particular, Amara (http://universalsubtitles.org) is becoming 
increasingly popular in higher education as a tool for crowdsourcing the captioning 
of videos and subtitling them into different languages. As long as the video has a 
publicly available address on the Internet, it can be added to Amara and anyone can 
caption or subtitle it.  The TED Open Translation Project has been extremely 
successful at this, with well over 33,000 translations of TED videos in 96 languages, 
performed by over 8600 volunteers (http://www.ted.com/OpenTranslationProject)  
 
This could be setup as a community activity and everyone with an interest in the 
OCL (faculty, committee members, volunteers, users, etc.) could be invited to help 
the cause by captioning each others' videos with the goal being 100% of videos 
being captioned.  The success of this effort depends on how well it's organized and 
promoted among potential volunteers. 

Summary of Findings and Recommendations 

Overall, the majority of documents in the Open Course Library have accessibility 
problems that will result in students or faculty with disabilities encountering 
challenges when accessing the course materials. In some cases these challenges are 
significant, and could result in students with disabilities being unable to effectively 
participate in courses that adopt this curriculum.  
 
Fortunately the most common problems are those related to document structure 
(especially headings and lists). These are the easiest to fix and generally do not 
require the course author or subject matter experts to be involved.  Also, these 
problems can be fixed directly within Google Docs.  

The second most common problems are those related to data tables. These 
encompass a broad range of severity. Many tables require no change to the table 
itself; they simply need the header row to be explicitly identified as such. This 
cannot be done within Google Docs, but can be done in Microsoft Word after the 
document is exported. However, some tables have severe structural problems that 
can only be solved by redesigning the table, and perhaps splitting large complex 
tables into multiple smaller tables. This will require input from the author.  

http://universalsubtitles.org/
http://www.ted.com/OpenTranslationProject


There are few images in the curriculum, but those that exist generally do not have 
alternate text. Many of these are highly specific images like charts, diagrams, and 
other discipline-specific content, so faculty members or subject matter experts will 
need to be involved in writing the descriptions of these images. Once the 
descriptions have been written, the process of adding alternate text to the images is 
not a highly skilled process and can be performed by anyone who learns the 
method.  It cannot be added in Google Docs, so it will need to be added using 
Microsoft Word after the documents have been downloaded.  

There are also several PDF documents throughout the OCL. Very few of these have 
been tagged, which is the first step in making an accessible PDF. After they have 
been tagged, they require the same sorts of fixes that other documents require, 
primarily those related to headings, lists, tables, and alternate text on images. 
However, performing these fixes on PDF documents is a much more specialized skill 
than doing so in Google Docs or Microsoft Word. Therefore PDFs will need to be 
fixed by someone with expertise on retrofitting PDF documents for accessibility 
using Adobe Acrobat Pro.  In a few cases, these PDFs are extremely complex, and up 
to 700 pages in length. Making these materials accessible would require an 
extraordinary effort.  

Foreign languages, not surprisingly, are used extensively in the three French and 
three Spanish courses. Fixing these problems will require a lot of work, since each 
word or phrase has to be defined individually.  However, it is not skilled work. This 
is work that could be done by students, perhaps for extra credit in a course or work 
study. This is a very critical problem that needs to be fixed. Otherwise students who 
use screen readers will be unable to use the curriculum for any of the foreign 
language courses.  

Many of the courses link to videos on external websites. A few of these videos are 
specifically mentioned in CAI's, but most are not and many were probably 
overlooked in this review. The Video section in this document describes the 
problems and solutions. The most critical and attainable first step is to be sure that 
all videos are captioned.  

The following is a recommended course of action for fixing the problems 
identified in this report:  

1. Assign faculty members who authored each course the task of applying 
solutions to their courses where those solutions require their subject matter 
expertise. If faculty members are unavailable for this task, invite other 
subject matter experts to help as needed.  The primary tasks that must be 
performed by the authors or subject matter experts are:  

a. Create a single document for each course that contains the alternate 
text for all images in their course. The CAI for each course identifies 
many of the documents that contain images without alt text, but some 



images may have been overlooked, so don't consider the CAI to be a 
definitive listing.  

b. Make other changes as identified in the CAI for their course that 
would result in a significant change in content (e.g., restructuring data 
tables).  

c. Within the CAI, clearly document their response to each problem with 
bold red text such as "Fixed", "See attached for alt text", or 
"Delegated" where the latter delegates the task to the next party in 
the workflow  

2. Assemble a team of workers to correct the remaining problems. This team 
could include:  

a. Members of the Accessibility committee 
b. Student workers  
c. An accessibility expert  

This team, led by the accessibility expert, could divide all courses among 
individuals or groups. During one marathon session, each individual or group 
could step through the problems identified in the CAI for their assigned 
course(s) and fix as many of those problems as possible within the allotted 
time. The accessibility expert could walk the entire group the steps for fixing 
each type of problem, and could be available to answer questions as they 
arose.   

3. Assign an ongoing team (perhaps student workers) the longer-term task of 
fixing the foreign language courses. Given the volume of work required to fix 
these courses, it is unrealistic to expect them to be fixed in a single marathon 
session.  

4. Create an Open Course Library account on Amara, then collect URLs of videos 
from all faculty and add each of those videos to Amara. Develop a plan for 
tracking and organizing the captioning project, then announce it to the OCL 
community and mobilize the crowd. Continue to promote the goal of 100% of 
videos captioned and report progress toward that goal in order to keep 
volunteers motivated. Offer rewards to individuals who are particularly 
active as volunteers.  

5. The more challenging problems (i.e., those requiring a higher level of 
accessibility expertise) could be prioritized and fixed by the accessibility 
expert or other partners as time and funding allows.  

6. Consider approaching Washington State School for the Blind about 
partnering on a grant proposal to develop a model open math course that 
embraces principles of universal design  

 

 
 


